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Evaluates: MAX11410MAX11410 Evaluation Kit

General Description
The MAX11410 evaluation kit (EV kit) demonstrates the 

24-bit multi-channel low-power delta-sigma ADC. The EV 

kit includes a graphical user interface (GUI) that provides 

communication from the target device to the PC. The GUI 

allows the user to configure all the registers and includes 
graphing software to display captured data and calculate 

the histogram and FFT.

EV Kit Contents
 ● MAX11410 EV kit

 ● Micro-USB cable

Features
 ● Easy Evaluation of MAX11410

 ● USB Powered

 ● Selectable On-Board Voltage Reference (2.5V, 1.25V)

 ● Optional External Clock (2.4576MHz)

 ● Isolated Power and Digital Communication

 ● Various Sample Rates and Sample Sizes

 ● Time Domain, Frequency Domain, and Histogram Plotting

 ● Savable Plots and Register Configurations

 ● Windows XP®, Windows® 7, Windows 

8.1-Compatable Software

 ● Fully Assembled and Tested

19-8483; Rev 0; 3/16

Ordering Information appears at end of data sheet.

Windows XP and Windows 7 are registered trademarks and registered service marks of Microsoft Corporation.

MAX11410 EV Kit Files

MAX11410 EV Kit Photo

FILE DESCRIPTION

MAX11410EVKitSetup.exe Application Program
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Quick Start

Required Equipment

 ● MAX11410 EV kit

 ● Windows XP, Windows 7, or Windows 8.1 PC

 ● Micro-USB cable

 ● Screwdriver

 ● Wires

Note: In the following sections, software-related items are 

identified by bolding. Text in bold refers to items directly 

from the EV kit software. Text in bold and underline 

refers to items from the Windows operating system. 

Procedure

The EV kit is fully assembled and tested. Follow the steps 

below to verify board operation:

1) Ensure that the jumpers/shunts are in their default  

locations. Refer to Table 2. 

2) Prior to starting the GUI, connect the EV kit hardware 

to a PC using the supplied micro-USB cable. The 

Power LED (DS1) should be green. 

3) The EV kit hardware is configured as a HID device 
so Windows should automatically begin installing 

the necessary drivers. Once the driver installation is  

complete, a Windows message appears near the 

System Icon menu indicating the hardware is ready 

to use. If the GUI was started before this message 

appears then restart the GUI. 

4) Visit www.maximintegrated.com/evkitsoftware to 

download the latest version of the EV kit software, 

MAX11410EVKitSetup.ZIP.

5) Save the EV kit software to a temporary folder. Unzip 

the .ZIP file and double-click the .EXE file to run the 
installer. A message box asking Do you want to allow 

the following program to make changes to this 

computer? may appear. If so, click Yes.

6) Follow the instructions on the installer and once  

complete, click Finish. The default location of the 

software is in the program files directory.

7) Launch the GUI and when it appears it should  

automatically connect to the hardware. The GUI 

should display EV Kit Hardware Connected in the 

lower right hand corner. 

8) Connect a signal to the desired inputs (A0–A9) on the 

screw connector (J1–J2) using a wire and a screwdriver. 

For example, connect the 1.25VREF testpoint to A2. 

9) In the GUI on the ADC Config tab, select AINP to 

AIN2 and AINN to GND for the Channel MUX. 

10) Click Convert and then Click Read Data and Status 

to see the converted data.

Detailed Description

Software Startup

When the software is started, it searches for the EV kit 

hardware and connects to it if found. If connection to the 

EV kit is successful, the GUI displays EV Kit Hardware 

Connected in the status bar’s lower-right corner. Then 

it writes default registers settings shown in Table 1 and 

reads all the registers to display on the GUI.

Status Log

The Status Log group box below the tabs displays all the 

actions the GUI performs. When an action is requested, 

the log confirms the action or shows an error message. 

The log can be cleared by pressing the Clear Log button.

Table 1. Startup GUI Registers Settings

SETTING VALUE

Digital Filter 60Hz SINC4

Sample Rate 59.8sps

MUX - AINP AIN2

MUX_AINN GND

Channel 0

Conversion Mode Continuous
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ADC Config Tab
The ADC Config tab provides an interface for configuring the IC from a functional perspective. The Block tab  

(Figure 1) provides for configuration of the input MUX, input path, data format, filtering, calibration, reference current 

sources, VBIAS, and power. To read all the configuration settings, click the Read All button in the Serial Interface block. 

When a setting is changed, the register associated with that setting is automatically written. The Status Log at the bottom 

of the GUI shows the value and register that was changed. Once the configurations are completed, start conversions by 

clicking Convert in the Serial Interface block. To read the data and status, click Read Data and Status on the lower-right 

of the GUI. This, first, reads the status register and then the data registers for the channel selected, displaying the value 

in volts and hex. For the data in volts to be calculated correctly, the Reference Voltage numeric box on the left should 

match the reference applied on the hardware. Note: All voltage values are input referred.

Figure 1. Quick-Start Connection Diagram
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Other Tab

The Other tab sheet (Figure 2) displays the thresholds, wait, GPIO, clock, and INT options. To read all the values on the 

tab, click Read All on the bottom right. The Channel Thresholds table allows reads/writes to the upper and lower threshold. 

The display unit can be changed to LSB, V, mV, or uV using the Threshold Units drop-down list. The TUR INT and 

TOR INT bits for the under and over range interrupts can be enabled by checking the checkbox for the channels desired.

To start a wait time, enter the desired decimal value in the Wait and Wait Extension numeric boxes. Note: Entering a 

value in the Wait numeric box does not perform a write to the part. Click Calculate Wait Time to see the equivalent wait 

time of these decimal values based on a 2.4576MHz clock. Click Start Wait Time to write the value in the Wait numeric 

box and begin the wait time.

Figure 2. EV Kit Software (ADC Config Tab > Other)
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Sequence Tab

The Sequence tab sheet (Figure 3) allows read/writes to the microcode registers (uC0-uC52). Click Read All to read 

all microcode registers. To write a register first select the hex value in the Value (Hex) column then type the desired 

hex value and press Enter on the keyboard. To start the sequence, enter the hex address of the microcode to start at in 

the Sequence Start Address and then click Start Sequence. During a sequence, the current address of the executing 

microcode can be read by clicking Read Current Address. 

Figure 3. EV Kit Software (ADC Config Tab > Sequence)
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Save/Load ADC Configuration
In the File menu, there are options to save or load a configuration file. Save ADC Config As.. and Save ADC Config 

read the registers from the connected MAX11410 EV kit and saves these values to an XML file. This includes the microcode 

registers as well. Load ADC Config gets register values from an XML file and writes them to the MA11410 EV kit. 

Scope Tab

The Scope tab sheet (Figure 4) is used to capture data and display it in the time domain. Sample rate and number of 

samples can also be set in this tab if they were not appropriately adjusted in other tabs. The Display Unit drop-down 

list allows LSB and voltages. Once the desired configuration is set, click on the Capture button. The right side of the 

tab sheet displays details of the waveform, such as average, standard deviation, maximum, minimum, and fundamental 

frequency. To save the captured data to a file, go to Options > Save Graph > Scope. This saves the setting on the left 

and the data captured to a csv file.

Figure 4. EV Kit Software (Scope Tab)
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DMM

The DMM tab sheet (Figure 5) provides captured data as a digital multimeter. Once the desired configuration is set, click 

the Capture button.

Figure 5. EV Kit Software (DMM Tab)
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Histogram

The Histogram tab sheet (Figure 6) is used to display a histogram of the captured data. Sampling rate and number of 

samples can also be set in this tab if they were not appropriately adjusted in other tabs. Once the desired configuration 

is set, click on the Capture button. The right side of the tab sheet displays details of the histogram such as average, 

standard deviation, maximum, minimum, peak-to-peak noise, effective resolution, and noise-free resolution. To use this 

histogram feature, uncheck the Disable Histogram checkbox. To save the histogram data to a file, go to Options > Save 

Graph > Histogram. This saves the setting on the left and the histogram data captured to a csv file.

Figure 6. EV Kit Software (Histogram Tab)
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FFT

The FFT tab sheet (Figure 7) is used to display the frequency domain FFT of the captured data. Sample rate and 

number of samples can also be set in this tab if they were not appropriately adjusted in other tabs. Once the desired  

configuration is set, click on the Capture button. The right side of the tab displays the performance based on the FFT, 

such as fundamental frequency, THD, SNR, SINAD, SFDR, ENOB, and noise floor. To save the FFT data to a file, go to 

Options > Save Graph > FFT. This saves the setting on the left and the FFT data captured to a csv file.

Figure 7. EV Kit Software (FFT Tab)
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Registers

The Registers tab sheet (Figure 8) allows the user to 

read/write to the ADC registers in hex format. Click Read 

All to read all registers and refresh the window with the 

register settings. To write a register first select the hex 

value in the Value (Hex) column then type the desired 

hex value and press Enter on the keyboard. The Bit 

Description section shows the format of the register 

selected in the Registers table.

Detailed Description of Hardware
The EV kit hardware includes the MAX11410 ADC,  

external reference (MAX6072), digital isolator 

(MAX14935), microcontroller (MAXQ622), isolated power, 

and jumpers to customize the configuration. See the links 

at the end of this data sheet for component information, 

PCB layout diagrams, and schematic. 

Reference Voltage

The ADC has three pairs of REFP/REFN pins to select 

as reference pins. In the GUI, go to the Block tab on the 

ADC Config tab and select the desired reference pins in 

the Reference block. When using the on-board voltage 

reference, move JP7 to the same REFXP selected in the 

GUI. If using REF0N, connect A1 on the screw terminal 

to GND or remove the AIN1 jumper on JP8 and connect 

AIN1 to GND. The default reference value is set to 2.5V. 

The EV kit also provides a reference of 1.25V by moving 

JP6 to 1.25VREF and changing the Reference Voltage to 

1.25V on the ADC Config tab. 

If using a user-supplied voltage reference, remove all 

jumpers on JP7, JP10, and JP11 and supply the reference 

on the REFXP and REFXN testpoints. If using REF0P/

REF0N connect the reference to A0/A1 on the screw  

terminal or remove the AIN0/AIN1 jumpers on JP8 and 

supplied the voltage on AIN0/AIN1 pins. In the GUI, 

change the Reference Voltage on the ADC Config tab 

to the user-supplied voltage. 

Figure 8. EV Kit Software (Registers Tab)
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ADC Inputs

The ADC inputs at the screw terminal (J1, J2) have series 

1kΩ input protection resistors. To bypass these resistors, 
remove the jumpers on JP8 and connect to the AINX pin 

on the right.

External Clock

The ADC can be configured to use an external clock. In 

the GUI, go to the Other tab on the ADC Config tab and 

change the clock to External using the Clock drop-down 

list. To use the on-board oscillator, move a jumper to the 

CLK position on JP4. To connect a user-supplied clock, 

remove any jumper on JP4 and connect the signal to the 

GPIO0/CLK testpoint. 

GPIO

Testpoints and jumpers are provided for the two GPIO 

signals. To set the input/output modes of the GPIO go to 

the Other tab on the ADC Config tab. If the GPIOs are 

set as inputs the jumpers JP5 and JP4 can be used to 

set the inputs high or low. See Table 2. Each GPIO has 

a 100kΩ resistor to GND on the EV kit. GPIO0 has an 
added option be being set to an external clock. See the 

External Clock section.  

User-Supplied SPI 

To evaluate the ADC on this EV kit with a user-supplied 

SPI bus, disconnect digital signals from the isolator by 

removed resistors R50–R53. Apply the user-supplied 

SPI signals to CSB, MOSI, MISO, and SCLK at the SPI 

and GPIO Header (J5). Make sure the return ground is  

connected to GND on the EV kit. 

EV Kit Power

By default the EV kit is configured to power from the USB 

5V. To power the board externally, first disconnect the 

USB. Then move JP14 to EXT_5V and connect 5V to the 

EXT_5V testpoint or to the power jack J6. Connect the 

USB for communication with the GUI.   

VDUT Power

VDUT powers the ADC and one side of the digital isolator. By 

default VDUT is connected to VADJ, which is the output 

of an adjustable LDO (MAX8842) set to 3.3V. To adjust 

VADJ, change resistors R80 and R81 according to the 

equation below for the desired output. Ensure VADJ is 

within the range 3.6V to 2.8V as the minimum voltage for 

the MAX6072 is 2.8V and the maximum voltage for the 

MAX11410 is 3.6V.

VADJ = 1.225V x (R80/R81 + 1)

VDUT can also be power externally with EXT_VDUT test 

point. To power externally, move JP12 to EXT_DUT and 

provide a voltage (3.6V to 2.7V) on the test point.

Table 2. Description of Jumpers

JUMPER JUMPER NAME JUMPER POSITION DESCRIPTION

JP1 AVDD Short* Connects on-board VDUT to AVDD

JP2 VDDREG Short* Connects on-board VDUT to VDDREG

JP3 VDDIO Short* Connects on-board VDUT to VDDIO

JP4 GPIO0/CLK

VDDIO Sets GPIO0 high (VDDIO)  Note 1

CLK Provides an external clock to GPIO0/CLK

GND Sets GPIO0 low (GND) 

JP5 GPIO1
VDDIO Sets GPIO1 high (VDDIO)  Note 1

GND Sets GPIO1 low (GND)

JP6 VREF

2.5VREF* Sets VREF to 2.5V

1.25VREF Sets VREF to 1.25V
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Table 2. Description of Jumpers (continued)

JUMPER JUMPER NAME JUMPER POSITION DESCRIPTION

JP7 REFP

REF0P Sets REF0P(AIN0) to VREF

REF1P* Sets REF1P to VREF

REF2P Sets REF2P to VREF

JP8 AINX Short* Connects AINX input to screw terminal through 1kΩ resistor

JP9 REFXP Short* Connects REFXP input to screw terminal through 1kΩ resistor

JP10 REF1N Short* Sets REF1N to GND

JP11 REF2N Short* Sets REF2N to GND

JP12 VDUT

EXT_VDUT VDUT is powered from external EXT_VDUT test point

VADJ* VDUT is powered from on-board VADJ

JP13 5V ENABLE Short* Enabled 5V from transformer T1

JP14 POWER
EXT_5V Board is powered from external EXT_5V test point or J6 power jack

VUSB* Board is powered from USB 5V

Component Information, PCB Layout, 

and Schematic
See the following links for component information, PCB 

layout diagrams, and schematic.

 ● MAX11410 EV BOM

 ● MAX11410 EV PCB Layout

 ● MAX11410 EV Schematic

#Denotes RoHS compliant.

Ordering Information

PART TYPE

MAX11410EVKIT# EV Kit
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Designator Quantity Description Manufacturer Manufacturer Part Number

C1, C3, C5, C9, C20, C23, C24, 

C40, C42, C44, C45, C50, C52, 

C60, C62, C63, C65, C90, 25 0.1uF 10%, 25V, X7R ceramic capacitor (0603) TDK C1608X7R1E104K080AA

C2, C4, C6, C21, C25, C26, C41, 

C43, C46, C47, C51, C53, C70, 

C71, C80, C81 16 1.0uF 10%, 16V, X7R ceramic capacitor (0603) Murata GRM188R71C105KA12D

C7 1 0.1uF, 10%, 50V, X7R ceramic capacitor (0805) Kemet C0805C104K5RACTU

C8 1 0.02uF,5%, 50V, COG ceramic capacitor (0805) Murata GRM21B5C1H203JA01L

C48, C49 2 18pF, 5%, 50V, COG ceramic capacitor (0603) Vishay VJ0603A180JXACW1BC

C61 1 4.7uF, 10%, 10V, X5R ceramic capacitor (0603) TDK CGB3B1X5R1A475K055AC

C64 1 10uF, 10%, 10V, X5R ceramic capacitor (0603) TDK C1608X5R1A106K080AC

C100, C101, C102, C103, C104, 

C105, C106, C107, C108, C109, 

C117, C118, C119, C120 0 100pF, 2%, 16V, PPS capacitor (0603) Panasonic ECH-U1C101GX5

C110, C111, C112, C113, C114 0 0.1uF, 2%, 16V, PPS capacitor (1210) Panasonic ECH-U1C104GX5

C115, C116 2 0.1uF, 2%, 16V, PPS capacitor (1210) Panasonic ECH-U1C104GX5

D1 1 Diode Array (SOT143-4) Infineon BAS 4002A RPP E6327

D2 1 5.6V Zener Diode (SOT-123)

Fairchild 

Semiconductor MMSZ5232B

DS1 1 Green LED (0805) Kingbright APT2012SGC

F1 1 Resettable Fuse, 750mA Trip Bourns MF-FSMF035X-2

J1, J2 2 10 pin Screw Connector, 2.54mm pitch TE Connectivity 1-282834-0

J3 1 USB Micro-B Receptical Molex 105017-0001

J4 1 10-pin (2x5) Header, 2.54mm pitch TE Connectivity 5-146258-5

J5 1 12-pin (2x6) Right Angle Header, 2.54mm pitch FCI 68021-412HLF

J6 1 DC Power Jack Kycon KLDX-0202-B

JP1, JP2, JP3, JP10, JP11, JP13 6 2-pin Header, 2.54mm pitch TE Connectivity 826936-2

JP4, JP7 2 4-pin T-Header, 2.54mm pitch TE Connectivity 826936-4

JP5, JP6, JP12, JP14 4 3 Pin Single Row Header 3M 961103-6404-AR

JP8 1 20-pin (2x10) Header, 2.54mm pitch FCI 67996-420HLF

JP9 1 4-pin (2x2) Header, 2.54mm pitch TE Connectivity 5-146258-2

R1, R3 2 100Ω, 1%, 1/10W resistor (0603) Vishay CRCW0603100RFKEA

R2, R4, R81 3 100kΩ, 1%, 1/10W resistor (0603) Vishay CRCW0603100KFKEA

R5, R40, R41, R42, R43, R45, R50, 

R51, R52, R53, R54, R55 12 28Ω, 1%, 1/10W resistor (0603) Vishay CRCW060328R0FKEA



R18, R19, R20, R21 0 DNP (0603)

R60 1 47kΩ, 1%, 1/10W resistor (0603) Vishay CRCW060347K0FKEA

R61, R62, R90, R115, R116 5 0Ω, 1%, 1/10W resistor (0603) Vishay CRCW06030000Z0EB

R63 1 10Ω, 1%, 1/2W resistor (0805) Panasonic ERJ-P06F10R0V

R80 1 169kΩ, 1%, 1/10W resistor (0603) Vishay CRCW0603169KFKEA

R100, R101, R102, R103, R104, 

R105, R106, R107, R108, R109, 

R110, R111, R112, R122 14 1kΩ, 1%, 1/10W resistor (0603) Vishay CRCW06031K00FKEA

R113, R114 2 15Ω, 1%, 1/10W resistor (0603) Vishay CRCW060315R0FKEB

R117 1 499Ω, 1%, 1/10W resistor (0603) Vishay CRCW0603499RFKEA

T1 1 1:2.6 Transformer Halo TGM-H281NFRL

TP1(VDDREG), TP2 (VDDIO), TP3 

(AVDD), TP28 (EXT_5V), TP30 

(3.3V_USB), TP31 (5V), TP32 

(VADJ), TP33 (EXT_VDUT), TP38 

(2.5VREF), TP39 (1.25VREF) 10 Red Test Point Keystone 5010

TP4 (CAPREG), TP5 (GPIO0/CLK), 

TP6 (GPIO1). TP7 (DOUT), TP8 

(DIN), TP9 (SCLK), TP11 (CSB), 

TP12 (CAPP) TP13 (CAPN) , TP24 

(REF1P), TP25 (REF1N), TP26 

(REF2P), TP27(REF2N) 13 White Test Point Keystone 5012

'TP29 (PGND), TP34 (GND), TP35 

(GND), TP36 (GND), TP37 (GND) 5 Black Test Point Keystone 5011

U1 1 ADC(TQFN -28) Maxim MAX11410

U2 1 Voltage Reference (uMAX) Maxim MAX6072AAUB25

U4 1 Microcontroller (LQFP) Maxim MAXQ622G-0000+

U5 1 Isolator (SOIC) Maxim MAX14935BAWE+

U6 1 H-Bridge Driver (SOIC) Maxim MAX256ASA+

U7 1 3.3V LDO(QFN) Maxim MAX8841ELT33+

U8 1 Adjustable LDO (QFN) Maxim MAX8842ELT+

U9 1 256KBit SRAM (SOIC-8) Microchip 23K256

X1 1 2.4576MHz Oscillator EPSON SG-210 STF

X2 1 12MHz Oscillator (3.2 x 2.5mm) CTS 403C35D12M00000

24 Jumpers open wire
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	R45-1
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	U5-14
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	U5-13
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	NetR60_2
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	U6-1
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	R61-2
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	R62-1
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	R62-2
	T1-4
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	R81-2
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	R90-1
	U9-7
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	C46-2
	C47-1
	C48-1
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	U9-6
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	C115-2
	C118-2
	J2-8
	JP10-2
	R18-1
	R20-2
	TP25-1
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	C115-1
	C117-1
	JP7-3
	JP9-3
	R18-2
	TP24-1
	U1-27

	REF2_N
	C116-2
	C120-2
	J2-6
	JP11-2
	R19-1
	R21-2
	TP27-1
	U1-26

	REF2_P
	C116-1
	C119-1
	JP7-4
	JP9-1
	R19-2
	TP26-1
	U1-25

	REFP
	J2-5
	JP9-2
	R110-1
	R111-1
	R112-1

	RR1
	J1-6
	R110-2

	RR2
	J1-7
	R111-2

	RR3
	J2-4
	R112-2

	RSTB
	J4-6
	U4-15

	SCLK_ADC
	J5-4
	R52-2
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	U1-19

	SCLK_MASTER
	R42-2
	U5-5
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	J4-1
	U4-41

	TDI
	J4-9
	U4-42

	TDO
	J4-3
	U4-44

	TMS
	J4-5
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	VADJ
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	J5-6
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	JP12-2
	R113-2
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	C105-2
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	C106-2
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	C107-2
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	C108
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	C109
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	C110
	C110-2
	C110-1
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	C114
	C114-2
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	C115-2
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	1.25VREF
	C24-2
	C26-2
	JP6-1
	TP39-1
	U2-6
	U2-7

	2.5VREF
	C23-2
	C25-2
	JP6-3
	TP38-1
	U2-1
	U2-2

	3.3V_USB
	C44-1
	C50-1
	C51-1
	C71-1
	C90-1
	R54-2
	R90-2
	TP30-1
	U4-22
	U5-1
	U5-7
	U7-6
	U9-8

	5V
	C64-1
	C65-1
	C80-1
	JP13-2
	TP31-1
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	U8-3
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	J1-2
	R100-2

	A1
	J1-3
	R101-2

	A2
	J1-4
	R102-2

	A3
	J1-5
	R103-2

	A4
	J1-8
	R104-2

	A5
	J1-9
	R105-2

	A6
	J1-10
	R106-2

	A7
	J2-1
	R107-2

	A8
	J2-2
	R108-2

	A9
	J2-3
	R109-2

	AIN0_N
	C101-2
	C110-2
	JP8-4
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	AIN0_P
	C100-1
	C110-1
	JP7-2
	JP8-2
	U1-1

	AIN1_N
	C103-2
	C111-2
	JP8-8
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	AIN1_P
	C102-1
	C111-1
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	AIN2_N
	C105-2
	C112-2
	JP8-12
	U1-8

	AIN2_P
	C104-1
	C112-1
	JP8-10
	U1-7

	AIN3_N
	C107-2
	C113-2
	JP8-16
	U1-10
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	C106-1
	C113-1
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	C109-2
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	C108-1
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	R51-2
	TP11-1
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	JP4-1
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	R2-2
	TP5-1

	GPIO1
	J5-8
	JP5-2
	R3-1
	R4-2
	TP6-1

	MISO_ADC
	J5-3
	R5-1
	R53-2
	TP7-1

	MISO_MASTER
	R41-2
	R45-2
	U5-6

	MOSI_ADC
	J5-2
	R50-2
	TP8-1
	U1-17

	MOSI_MASTER
	R40-2
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	R117-1

	NetF1_1
	F1-1
	J3-1
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	R113-1
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	R122-2
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	R114-2
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	R115-1
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	R108-1
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	JP8-19
	R109-1
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	R122-1
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	R1-2
	U1-21
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	R5-2
	U1-15

	NetR40_1
	R40-1
	U4-11

	NetR41_1
	R41-1
	U4-12

	NetR42_1
	R42-1
	U4-13

	NetR43_1
	R43-1
	U4-14

	NetR45_1
	R45-1
	U4-45

	NetR50_1
	R50-1
	U5-14

	NetR51_1
	R51-1
	U5-13

	NetR52_1
	R52-1
	U5-12

	NetR53_1
	R53-1
	U5-11

	NetR60_2
	R60-2
	U6-1

	NetR61_1
	R61-1
	U6-8

	NetR61_2
	R61-2
	T1-1

	NetR62_1
	R62-1
	U6-5

	NetR62_2
	R62-2
	T1-4
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